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1 Úvod 

V dnešní ekonomicky napjaté době každý přemýšlí, jak co nejvíce ušetřit na energiích. 
Technická oblast, která se tímto problémem zabývá, se nazývá řídicí nebo též regulační tech-
nika [5]. Ta říká, že pokud mají být snižovány výdaje za energie, je bezpodmínečně nutné 
systémy správně řídit (regulovat). 

Na Vyšší odborné škole v Sezimově Ústí vznikla v roce 2011 Laboratoř aplikované in-
formatiky a fyziky [4], která byla postupem času vybavena laboratorními modely (reálnými 
technologiemi), na kterých se mohou studenti učit řídicí technice [5]. Většina těchto učebních 
pomůcek vznikla v rámci absolventských prací našich studentů [6], [1], [3], [2]. Tyto labora-
torní modely lze řídit pomocí osobních počítačů s programovým prostředím Matlab/Simulink 
s Real Time toolboxem a multifunkční kartou MF 624 od firmy Humusoft s. r. o. Tato vstup-
ně-výstupní karta má mimo jiné, podobně jako PLC automaty, 8 digitálních vstupů, 8 digitál-
ních výstupů, 8 analogových vstupů a 8 analogových výstupů. 

Cílem této práce bylo vytvořit simulátor, který bude názorně prezentovat funkci multi-
funkční karty MF 624. Digitální vstupy karty (logická 0 a 1) jsou ovládány páčkovými přepí-
nači, digitální výstupy jsou reprezentovány LED diodami (červenými a zelenými). Analogový 
vstup karty je ovládán potenciometrem a analogový výstup je znázorněn pomocí bargrafu. 

Struktura této práce je následující. V kapitole 2 se nachází simulinkové komunikační 
schéma. V přílohách je uvedeno bez bližšího popisu schéma zapojení elektroniky, navržený 
plošný spoj, objednávky součástek a manuál k převodníku pro bargraf LM3914. 

 

 
obr. 1: Simulátor MF 624 – osazený plošný spoj 
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2 Simulinkové komunikační schéma 

Na obr. 2 je zobrazeno simulinkové komunikační schéma pro základní ovládání simulá-
toru MF 624. Pod maskou SIMULATOR MF 624 Real Time Communication  tohoto 
schématu je nastavena vlastní komunikace počítače se simulátorem pomocí Real Time tool-
boxu, viz obr. 3. 
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obr. 2: Simulátor MF 624 – simulinkové komunikační schéma 
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obr. 3: Simulátor MF 624 – simulinkové schéma – Maska SIMULATOR MF 624, viz obr. 2 
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Na následujících obrázcích je znázorněno, jak jsou nastaveny simulinkové bločky 
RT Out a RT In ze schématu na obr. 3. Proměnné Ts, DAi a ADi použité v těchto bloč-
cích jsou nastavovány v masce SIMULATOR MF 624 Real Time Communication ve 
schématu na obr. 2. 

   
obr. 4: Simulátor MF 624 – nastavení analogových vstupů a výstupů bločků Real Time toolboxu 

   
obr. 5: Simulátor MF 624 – nastavení digitálních vstupů a výstupů bločků Real Time toolboxu 
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2.1 Přívodní vodič MF 624 – Simulátor MF 624 

Následující tabulka uvádí přiřazení barev přívodního 24 žilového vodiče k jednotlivým 
pinům Simulátoru MF 624 (schéma v příloze). 

 

PIN Signál Barva vodiče  PIN Signál Barva vodiče 

1 AD0 červená modrá    
2 AD1  20 DA0 hnědá modrá 
3 AD2  21 X2: T3OUT šedá1 
4 AD3  22 DA2  
5 AD4  23 DA3  
6 AD5  24 DA4  
7 AD6  25 DA5  
8 AD7  26 –12V zelená 
9 AGND modrá 27 +12V žlutá 

10 DA6  28 +5V červená 
11 DA7  29 GND černá 
12 DIN0 fialová 30 DOUT0 bílá růžová 
13 DIN1 růžová šedá 31 DOUT1 červená hnědá 
14 DIN2 bílá zelená 32 DOUT2 bílá červená 
15 DIN3 hnědá zelená 33 DOUT3 hnědá žlutá 
16 DIN4 bílá žlutá 34 DOUT4 hnědá 
17 DIN5 bílá 35 DOUT5 bílá šedá 
18 DIN6 bílá modrá 36 DOUT6 hnědá šedá 
19 DIN7 hnědá růžová 37 DOUT7 růžová 

Literatura 
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COP Sezimovo Ústí, 2014. 

[4] ROUBAL, J., Výukové materiály pro Laboratoř aplikované informatiky na VOŠ (Bakalář-
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literatura, 2011. 
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Poděkování 

Autor této práce by rád poděkoval výše uvedeným spolupracovníkům a studentům za 
pomoc při realizaci tohoto projektu a škole za poskytnuté finanční prostředky, které činily cca 
2 000 Kč. Časová náročnost projektu byla 64 hodiny. 

                                                 
1 Na PIN 21 je přiveden signál T3OUT z konektoru X2 (PWM 5i voltový výstup). 
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Několik zásad v prostředí EAGLE 

• Schematic 
o http://ucimeseeagle.cz/  
o View → Grid: Size: 100 mil 
o Edit → Add: frames - A4L-LOC (DINA4_L .. jednoduchý) 

• Board 
o View → Display/hide layers 1, 16-28, 39-43, 45, 47-52, 116 
o View → Grid: Size: 5 mm (pro okraje plošného spoje) 
o View → Grid: Size: 50 mil (pro rozmístění součástek) 
o Šířka vodivé cesty cca 40 mil (pokud tenčí, tak jen pro krátké cesty) 
o Šířka mezi dvěma vodivými cestami alespoň 16 mil 

• Měřítka 
o    1 inch =        2.54 cm =     25.4 mm 
o     1 mil  =  0.00254 cm = 0.0254 mm 
o     5 mil  =    0.0127 cm =   0.127 mm 
o   50  mil =      0.127 cm =     1.27 mm 
o 100  mil =      0.254 cm =     2.54 mm 

Výroba plošného spoje v laboratoři C110 u ing. Bumby 

• Vytisknout motiv plošného spoje na pauzovací papír 
• Osvítit fotocitlivý kuprextid UV lampou 

o nejprve zapnout UV lampu alespoň na 20 minut 
o z kuprextitu odstranit ochranou (modrou) fólii 
o na kuprextit umístit správně pauzovací papír s vytisklým motivem plošného spoje 
o kuprextit s pauzovacím papírem vložit pod UV lampu na 1 minutu a 40 sekund 

• Vyvolat motiv plošného spoje na fotocitlivém kuprextitu 
o kuprextit položit do misky a postříkat ho vývojkou (pozitivní) tak, aby byla měď 

„utopená“, pak kuprextid koupat ve vývojce 
o na kuprextitu začne postupně vystupovat motiv plošného spoje 
o kuprextit koupat dokud nepřestane pouštět fialovou barvu (pak případně postříkat 

místa, která nebudou vyvolaná) 
o pak z kuprextitu včas umýt (rukou) vývojku, aby byla vidět čistá měď 

• Vyleptat plošný spoj na kuprextitu 
o kuprextit ponořit do leptacího roztoku (chlorid železitý) tak, aby pod kuprextitem 

nezůstaly vzduchové bublinky a cca každých 15 minut „promýchat“ 
o po vyleptání kuprextit umýt a osušit 

• Mechanická úprava kuprextitu 
o v kuprextitu vyvrtat otvory pro nožičky součástek, šroubky atd. + srazit hrany po 

vrtání větším tupým vrtákem na straně součástek 
o kuprextit ostříhnout, zapilovat hrany, dočistit pilníčkem měděnou stranu po vrtání 
o kuprextit na měděné straně očistit houbičkou a lihem (odstranit fotocitlivou vrstvu) 

• Osazování součástek  
o kuprextit (měděnou stranu) natřít kalafunou rozpuštěnou v lihu a nechat ji zasch-

nout (ideálně na přímém slunci) 
o kuprextit ze strany součástek polepit samolepkou s ochranou fólií 
o samolepku s ochranou fólií propíchat v místech vývodů součástech 
o na kuprextid umístit součástky a připájet je 
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Výroba modelu v čase 

• 09.11.2015 – 1,0h – učení se v Eagle 
• 10.11.2015 – 4,5h – schéma DOUTs + indikace napájení 
• 11.11.2015 – 1,5h – plošný spoj DOUTs 
• 12.11.2015 – 4,5h – plošný spoj DOUTs 
• 13.11.2015 – 5,5h – schéma DA + plošný spoj DA + úprava plošného spoje DOUTS 
• 14.11.2015 – 1,0h – plošný spoj DA 40i pinový konektor 
• 15.11.2015 – 2,0h – plošný spoj DA + plošný spoj DA 40i pinový konektor 
• 15.11.2015 – 2,0h – výběr součástek na www.gme.cz 
• 16.11.2015 – 2,0h – schéma pro DINs (přepínače) + plošný spoj 
• 18.11.2015 – 2,0h – úprava DPS podle komentářů J. Bumby 

o existuje ULP fce dril–aid.ulp, která upraví vnitřní průměry otvorů v ploškách (pro 
ruční vrtání doporučuji 24mil (0,6mm)) 

o překryvné plošky vložit na vodivou cestu, pak posunout na místo 
o pro vrtání otvorů pro ruční výrobu doporučuji použít prokovy (diameter 150mil, 

drill 1.5mm) a pojmenovat je GND, aby se spojily s rozlitou mědí 
o při vytváření polygonů vypnout osamocené ostrůvky (třetí ikona OFF), Isolate: 

40mil, polygon pojmenovat GND 
o na výkrese DPS přidat kóty 

• 19.11.2015 – 2,0h – úprava schématu a DPS podle komentářů J. Bumby 
o schéma: jméno součástky nahoře, hodnota dole 
o polygon 

• 20.11.2015 – 2,0h – oprava schématu (potenciometr) a DPS (bargraf zleva do prava) 
• 08.12.2015 – 1,5h – přidání jumperů k analogovým signálům 
• 09.12.2015 – 1,5h – A. Fulín (VOŠ2) – leptání DPS 
• 14.12.2015 – 0,75h – L. Sedlák (VOŠ1) vytvořil v AutoCADu výkres pro panel do 

krabičky 
• 16.12.2015 – 0,5h – A. Fulín (VOŠ2) – vrtání DPS 
• 15.01.2016 – 1,0h – A. Fulín (VOŠ2) – vrtání DPS + nátěr kalafunou 
• 22.01.2016 – 0,25h – A. Fulín (VOŠ2) – 2. nátěr kalafunou 
• 28.01.2016 – 1,5h – A. Fulín (VOŠ2) – gravírování potisku DPS (asi to takto dělat 

nebudeme) 
• 02.02.2016 – 2,5h – potisk DPS + objednání součástek 
• 04.02.2016 – 0,5h – přišly součástky z TME (bez vodiče), cena 948 Kč – vše bez vodiče 
• 05.02.2016 – 0,0h – přišly součástky z GME (2 balíky), cena 238 Kč – páčkové 

vypínače + 1197 Kč – zbytek z GME 
• 08.02.2016 – 4,0h – osazení plošného spoje součástkami (kromě LED diod) 
• 10.02.2016 – 2,0h – export panelu do krabičky do dxf (pro laserovou gravírku) 
• 11.02.2016 – 0,5h – D. Krž – vypálení panelu do krabičky na laserové gravírce 
• 11.02.2016 – 0,0h – přišly součástky z TME (vodič) 499 Kč – 24 žilový vodič 
• CELKOVÁ CENA SOUČÁSTEK PRO SIMULÁTOR MF624 JE 2000Kč (některé 

součásky z nákupů byly doplňky jiných modelů) 
• 11.02.2016 – 2,0h – příprava a tisk potisku 
• 11.02.2016 – 2,0h – osazení plošného spoje LED diodami a vypínačem 
• 12.02.2016 – 0,25h – D. Krž – vypálení otvorů pro konektory a vypínač do krabičky 
• 12.02.2016 – 1,0h – vsazení desky plošného spoje do krabičky 
• 22.02.2016 – 1,5h – vsazení vypínačů a potenciometru na víčko krabičky 
• 22.02.2016 – 2,0h – připájení vypínače a potenciometru + oživení simulátoru 
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• 23.02.2016 – 1,0h – schéma pro DINs a vypínač napájení (D. Doležal (VOŠ1)) 
• 24.02.2016 – 0,5h – D. Doležal (VOŠ1) diskuse nad funkcí převodníku pro bargraf 
• 24.02.2016 – 1,5h – D. Doležal (VOŠ1) napájel přívodní kabel – konektor do MF624 
• 24.02.2016 – 2,5h – manuál k elektronice + simulinkový komunikační soubor + štítky a 

popisek 
• 25.02.2016 – 1,5h – D. Doležal (VOŠ1) napájel přívodní kabel – konektor do Simulátru 

MF624 
• 25.02.2016 – 1,0h – já + D. Doležal (VOŠ1) nalazen převodník pro bargraf 
• 25.02.2016 – 0,75h – úprava schématu a DPS – převodník pro bargraf +12V 
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Koupit1Rychlé vložení do košíku dle kódu

Obrázek Kód Název Dostupnost Cena bez DPH Cena za položku s DPH

656-233 Teplem smršťovatelná trubičková bužírka KSS
F0927F-2 Ano 15,7025 Kč 19,00 Kč

656-638 Teplem smršťovatelná trubičková bužírka KSS
F0927F-1 Ano 10,7438 Kč 13,00 Kč

661-063 Fotocuprextit FR4 160x100x1,5 jednovrstvý Ano 63,6364 Kč 77,00 Kč

623-164 Distanční sloupek DA5M3X10 nikl VIGAN Ano 26,0331 Kč 31,50 Kč

623-153 Distanční sloupek DI5M3X20 nikl VIGAN Ano 33,5537 Kč 40,60 Kč

122-011 CT 2,2u/16V YHC-CA42 RM2,54 20% Ano 3,4711 Kč 4,20 Kč

800-181 Konektor se zámkem PSH02-10WG Ano 7,7686 Kč 9,40 Kč

800-092 Konektor se zámkem PFH02-10P Ano 4,1322 Kč 5,00 Kč

631-031 P-B069B 12 / 2016 171,9008 Kč 208,00 Kč

824-006 DIL20PZ Ano 42,9752 Kč 52,00 Kč

323-002 LM3914 DIP18 Ano 45,4545 Kč 55,00 Kč

824-005 DIL18PZ Ano 10,7438 Kč 13,00 Kč

832-023 Oboustranný kolík S2G20 2,54mm Ano 9,4215 Kč 11,40 Kč

832-014 Zkratovací propojka JUMP-SW+ Ano 9,8488 Kč 11,92 Kč

511-204 LED 5MM RED 6,5/40° BL-B4534-L Ano 17,1074 Kč 20,70 Kč

511-122 LED 5MM GREEN 4,2/60° HLMP-3507 Ano 29,0083 Kč 35,10 Kč

511-205 LED 5MM YELLOW 3/40° BL-B3134-L Ano 3,3058 Kč 4,00 Kč

624-053 LDC500 Ano 24,9983 Kč 30,25 Kč

110-065 RM 470R 0207 0,6W 1% Ano 20,4056 Kč 24,69 Kč

110-097 RM 10k 0207 0,6W 1% Ano 19,2053 Kč 23,24 Kč

110-078 RM 1K6 0207 0,6W 1% Ano 4,2975 Kč 5,20 Kč

110-075 RM 1K2 0207 0,6W 1% Ano 2,1488 Kč 2,60 Kč

110-087 RM 3k9 0207 0,6W 1% Ano 2,1488 Kč 2,60 Kč

110-089 RM 4k7 0207 0,6W 1% Ano 4,2975 Kč 5,20 Kč

110-081 RM 2k2 0207 0,6W 1% Ano 2,1488 Kč 2,60 Kč

113-055 PC1621NK010 Ano 14,0496 Kč 17,00 Kč

624-086 P-S8860 Ano 15,7025 Kč 19,00 Kč

210-019 Bipolární tranzistor BC337-40 TO92 Ano 21,1570 Kč 25,60 Kč

800-067 Konektor MLW40G Ano 14,0496 Kč 17,00 Kč

800-013 Konektor PFL40 Ano 12,3967 Kč 15,00 Kč

Obsah
košíku

Osobní údaje,
doprava a platba

Kontrola
údajů

Předobjednávka
nedostupného zboží
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Zpět do obchodu Přejít k pokladněPřepočítat košíkVerze pro tisk

Převod košíku Vyberte pobočku

webmaster SEO Copyright 1990–2016 GM electronic, spol. s r. o.

801-027 Konektor CAN 37 V S Ano 36,3636 Kč 44,00 Kč

801-028 Konektor CAN 37 Z Ano 10,7438 Kč 13,00 Kč

801-024 Konektor CAN 37 V Ano 10,7438 Kč 13,00 Kč

801-111 KRYT CANN 37 Ano 21,4876 Kč 26,00 Kč

656-607 Ochranný kryt konektoru CANON KSS HR-37F Ano 56,0909 Kč 67,87 Kč

800-083 Konektor MLW06G Ano 8,2645 Kč 10,00 Kč

800-081 Konektor PFL06 Ano 19,0083 Kč 23,00 Kč

631-150 P-B068H Ano 50,4132 Kč 61,00 Kč

Celková cena dostupných položek 703,0283 Kč 851,00 Kč

Nedostupné položky jsou řešeny v kroku 4.
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150 000 výrobků v nabídce
2700 každodenně balíků
127 000 zákazníků ze 122 zemí

Váš účet Nabídky Symboly zákazníka Proforma faktury Historie prodeje Parkoviště Aplikace Informování QuickBuy Porovnávač

OBJEDNÁVKY
ON-LINE

KATALOG
ON-LINE OBJEDNEJ KATALOG

Jsi správně přihlášený cop_c227 ( 2232731 )

HLEDEJ PRODUKT

vyhledávání výrobků v 23 jazycích

Váš účet Nabídky Symboly zákazníka Proforma faktury Historie prodeje Parkoviště Soubory Aplikace Informování QuickBuy

PANEL

* Všechny ceny jsou uvedené bez DPH a neobsahují náklady na dopravu, které se dopočtou do objednávky jako samostatná položka. Hodnotu nákladů na dopravu najdete zde: "Jak
nakoupit".

NEWSLETTER TME

Informace o událostech, akcích a nových výrobcích přímo
do Vaší schránky.

?

Podmínky
Ukončit odebírání newsletteru

symbol zboží objednané množství

QUICK BUY ?

Další volby Quick Buy

VÍTEJTE V TME CZECH REPUBLIC S.R.O.HLAVNÍ STRANA JAK NAKOUPIT NÁPOVĚDA O FIRMĚ KONTAKT

?

Nálepka Nabídka Množství Stav skladu Informování * Cena netto * Hodnota netto

DC-10GWA
Zobrazovač: LED; sloupec; zelená; 2,2-5,6mcd; 25,4x10,16mm
Výrobce: KINGBRIGHT ELECTRONIC
Označení výrobce: DC-10GWA

 ks

Dodávky do skladu

1308
ks �

24.59
CZK

~24.59
CZK

TA241911T
Kryt: univerzální; X:191mm; Y:240mm; Z:107mm; TEMPO; ABS;
šedá; IP65
Výrobce: FIBOX
Označení výrobce: TA241911T

 ks

Dodávky do skladu

9
ks �

278.73
CZK

~278.73
CZK

LIYY24X0.25
Kabel; licna; Cu; 24x0,25mm2; PVC; šedá; 500V; LiYY
Výrobce: HELUKABEL
Označení výrobce: 18043

 m

Dodávky do skladu

0
m

82.45
CZK

~824.5
CZK

ODU
Vývodka; PVC; černá; Tl.stěny:1,6mm; Økab:8÷17mm; Otv:
Ø20mm

 ks

Dodávky do skladu

4171
ks �

3.378
CZK

~33.78
CZK

Hodnota složky netto : ~1161.6
CZK

� � � �Seznam složek / MF624 (4)
Datum vytvoření: 2016-02-02 / Datum změny: 2016-02-02

MF624

LINECARD

Produkty uvidíte, až vyberete výrobce nebo kategorii

všechny kategorie

všichni výrobci

a používá soubory cookie. Pokud se chcete dozvědět více o souborech cookie a možnostech jejich nastavení, klikněte zde.Zpětná vazba
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